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Introduction
See Picture at bottom of the page
More information is available in the BMPTOICO.FAQ file included in the Zip; you can also read it
from BMPTOICO's Help menu by selecting FAQ.

· File Formats:    .ICO, .BMP, plus JPG/JPE (registered version only).

· Multi-Icon ICO resource files fully supported

· All Colors:    Monochrome to 16 millions, with the exception of 32K (16-bit). 
· 16 millions (24-bit) BMPs or JPGs will be set to Windows System palette if your Video 
Mode is less than High or True Colors
· 16 millions (24-bit) Icons open only in High or True Colors

You can change your Video Mode via Window's Control Panel, by selecting "Display", 
then "Settings". 

· Dimensions: Anything from 8 x 8 pixels to 72 x 72 pixels, including non-square images; if 
the image is a BMP and it is bigger than 72 x 72, the Crop form will open automatically, 
but it creates only square images.

· Conversion Wizards (see How to Convert, BMP to ICO, ICO to BMP).

· Zoom on the current Image, and check an Icon's Transparency

· Edit the current Image (Images with 256 or more colors can only be edited if your Video 
Mode is set to High or True Colors); see TouchUp Editor

· Save Edited, Crops, Extracted Images, etc.; see Buttons.

· Crop    BMPs:    see Crop a BMP to Icon Size

· View All Images in a Directory; see View All.



How to Convert
To Load (Open) an image:

Double-Click on its filename.    The image viewing area is at the upper left, with the 
dimensions and number of colors on the tab, and the name of the image. If the Icon file 
contains more than one icon, more tabs will appear.    If there are more than three icons in 
the file, a >> button will let you navigate through all the icons.

Desktop Simulation (Icons only):
If the Opened Image is an Icon, you can see how it will look on a busy wallpaper    by 
checking this option.

The Conversion Wizards:
·    BMP to ICO:    You may select a Transparent Color for the icon; 24-bit BMPs can be 

converted to 256-color Icons (see BMP to ICO for more on this Wizard).

·      ICO to BMP:    If the Icon has Transparency, you may change the Background Color 
for the bitmap (see ICO to BMP for more on this Wizard).

·      File Name:    The last page allows you to change the default filename; it might be the 
only page shown (for ex. if an Icon has no Transparency, you cannot change its 
Background color).    The new file will be saved in the current directory, unless it is read-
only (see File Lists).

The default file name will be the same as that of the image, the target .ICO or .BMP 
extension being added automatically.    For example, the BMP version of ICOTEST.ICO 
will be saved as ICOTEST.BMP.    

Some Convert> file names will be slightly different from the original file name, to indicate 
their status (Edited, Cropped) and to avoid overwriting valid pictures:

When the Conversion is done:
The converted image is automatically opened into BMPTOICO.



BMP to ICO
Transparent Color, Crop a BMP, Resize the Crop Cursor

BMP Formats:
Only valid Windows BMPs, with up to 16 millions colors. If the BMP is larger than 72 x 72 
pixels, the Crop module will open automatically, with the BMP loaded full size. You can then 
Crop an Icon size Image out of it; if the size of the Image is between 32 x 32 and 72 x 72, a 
Crop the BMP button will allow you to access the Crop module.

If you Load a 16 millions Colors BMPs when your Video Mode is set to 16 or 256 Colors, 
BMPTOICO uses a special, full screen 24-bit Loading Module. This ensures that the image
is alone on the screen and that BMPTOICO captures the system's palette with the proper 
colors; if the Image is bigger than 72 x 72 pixels, it will be sent to the Crop module when you
Click the Load button (you can also Cancel the operation).

Some BMP Images cannot be loaded into BMPTOICO. If a bitmap...
... is 16- bit
... is in the OS/2 format.
... cannot fit into your memory

JPG Images:    when you register BMPTOICO, you will be able to use the    VBJPEG.DLL file
(read the file BMPTOICO.FAQ, or Select "FAQ" from the Help menu to see how to get this 
file).    Once you have registered and installed the DLL, a CheckBox marked JPEG will 
appear under the BMP File List; it will be enabled if a directory contains JPG/JPE files.    
Check the box to replace the BMP list with a JPG/JPE list.    Once loaded (via the 24-bit 
Loading Module), JPG/JPE images are treated as BMPs internally, and all the BMP 
functions are also available.    You may encounter a very, very rare GPF when you use that 
module, there is nothing I can do about it... 

Converting to ICO Wizard    (Convert > ICO button)

· You may create Transparency for the Icon before Converting it.

· The last page of the Wizard allows you to change the default filename for the ICO file.

· If the Bitmap size is one of the three Windows 95 formats (16 x 16, 32 x 32 or 48 x 48 
pixels), you can save additional Windows icons in the ICO file: on the Save Name page, 
you will be presented with this option:

Check the format(s) you wish to add to the Icon; you cannot delete the current format of 
the bitmap (its CheckBox will be greyed).    Windows 95 uses the 16 x 16 Icon for the 
small icon at upper left of the forms, in the TaskBar, and in the Explorer if you set it to 
"Small Icons"; the 32 x 32 icon is used otherwise.    I have no idea how it uses the 48 x 



48 format, but it seems to be a standard... <grin>

· If your Video Mode allows full display of all colors (High or True Colors), and your BMP 
has 16 millions colors, the Wizard's first page will ask you to save the Icon with either 16 
millions colors (not recommended) or only 256; in that case, the default palette is 
Windows System's, and it might not be the best: an Optimize button allows you to build 
a palette from the actual colors in the bitmap.    You may Save the Icon with 16-millions 
colors, but the resulting file will be much larger, and such Icons may crash other Icon 
Editors.

IMPORTANT NOTE:    256 color Icons are NOT suitable as Icon Property for 16-bit 
application forms (written in VB, Delphi, Visual C++, etc.); you should always use 16-
color only Icons if you write 16-bit apps.



Transparent Color for the Icon
What it is...

With Windows Icons, you may select a color to be transparent so that the Desktop's 
Wallpaper will show through the icon's surroundings.

Icons are actually special bitmaps saved with two pixel definitions: one for the image itself, 
with all Transparent pixels set to Black, and a monochrome bitmap, called the Mask, with all 
Transparent pixels set to White:

To Change it:
A page of the Convert BMP>ICO Wizard will allow you to set the Color that will be 
Transparent in the Icon; you will see the Mask of the Icon, so you can check what you are 
doing.    You can also Edit an existing Icon.

All the pixels that are of the selected color will be made transparent, so be careful if you click on 
a color you don't want to be Transparent for some pixels (you can Edit the resulting Icon later to 
make those pixels as Foreground color again).    Another solution to this problem is to edit the 
BMP file before loading it into BMPTOICO, coloring the area you wish to be transparent with a 
color that you don't use anywhere else:



Crop a BMP to Icon Size

If the BMP you wish to Load    is larger than 72 x 72 pixels, the Crop form will automatically 
open.    If the image is larger than the View window, there will be a vertical and/or an horizontal 
scroll.    You can also Crop BMPs that are smaller than 72 x 72 pixels by clicking the Crop the 
BMP button which will appear on the main form when you open such images (this button is 
disabled after you have Edited the bitmap).

The Crop form opens automatically when you Grab from Screen.

Crop to Icon Size:

Select the Crop Size
First Select the Size of the Cropped Image in the combo box at upper right. The sizes are (in
pixels): 16x16, 32x32, 48x 48 and    72x72; if the image is smaller than 72x72, you can only 
select sizes that are smaller than the image.

The Cursor 
The Cursor is a transparent rectangle with an inverse-color border. Its position is displayed 
above the View Window, and its content will show in the Crop Icon at the right. The Icon 
image is updated automatically when you move the Cursor. If you prefer a Black border for 
the Cursor, right-click it, or click the Black border checkbox.

Move the Cursor by Clicking the Arrow buttons or Pressing the Arrow keys (a bit faster due
to key Autorepeat). You can change the Stepping rate of the buttons.To move even faster, 
Click the Cursor near its center, then Drag and Drop it where you want it. The Cursor always
stays inside the view window:    use the Vertical and/or Horizontal scrolls to reach other 
areas of the BMP.

Shrink or Blow an area (so that it fits into the selected Crop Size) by Resizing the Cursor: 
click the    Cursor Size button to access to that function.

Other Buttons: 
Zoom button:    see a blowup of the Crop Icon (you can also press Alt-Z).
Full View Menu: view the complete image (disabled if the whole image fits into the View 

Window).

When you are happy with the Icon...



Click on the Load button. The small image will show in BMPtoICO's main form, ready to be 
Saved or Converted into an Icon.    You can also Cancel the Crop operation at any time.



Resize the Crop Cursor

If your image is small enough, you might want to Shrink it all to make your Icon. Or, you might 
want to use only an area of the image, but it is smaller or bigger than the Selected Crop Size:    
Click the Resize Cursor button: the Resize frame will expand.  Play with the <<    >> buttons, 
and watch the results in the Cropped Icon... The Resize Step scroll changes the resizing step of
the cursor (the Cursor can be as small as 4 x 4 pixels, but never bigger than the View Window). 
The four main Arrow buttons, Drag and Drop of the Cursor and the View Window Scrolls remain 
active, as well as all the visible buttons.

Shrink an area:    
Click the << or the >> button to enlarge the Cursor. The area under it will be Shrunk to the 
Selected Crop Size:

Blow an area:    
Click the << or the >> buttons to reduce the Cursor size. The area under it will be Blown to 
the Selected Crop Size:

If you like the result...
Click the Load button to send it back to BMPTOICO, or Click the Reset Cur. button to reset 
the Cursor to the Selected Crop Size.    





ICO to BMP
Background Color for the Bitmap

ICO Formats:
Only valid Windows 3.x and Windows 95 Icons  can be Loaded into BMPTOICO; OS/2 
Icons are not supported. 

Windows 3.x Icons: 
They always measure exactly 32 x 32 pixels and can have only the Windows Standard 16 
colors: .    They show as a rectangle because pixels are not 
square. Icons that have 16 colors, but not the standard ones, will be displayed by 
Windows with their nearest standard colors if your Video Mode is less than High Colors.

Windows 95 Icons: 
They can contain more than one icon, have any size from 8 x 8 to 72 x 72 pixels, and can 
have any number of colors, but you must set your Video Mode to High or True Colors to 
Load 16 millions-color Icons. 

If the ICO file is a resource file with more than one icon,    BMPTOICO will Load them all.    
You can, if you wish, Save each icon to a separate ICO file

Converting to BMP Wizard (Convert > BMP button) 

Bitmaps are saved with a color definition for each pixel: all pixels become part of the 
Foreground. If the Icon you are converting has Transparency, you may change the    
Background Color before converting.



Background Color for the Bitmap
What it is...

If the loaded Icon has a Transparent Background, you will be able to see BMPTOICO's grey 
background through it.    When you save it as a BMP, this grey background will be saved as 
the grey color, not as Transparent, a concept that bitmaps ignore.

No Transparent Background?
You can create Transparency in the Touch Up Editor before Converting the Icon to BMP 
(Click the Edit button; note: 256-color or 16 millions color Icons cannot be Edited if your 
Video Mode is set to 16 or 256 Colors).

To Change it:
If you want the Transparent Background to be of a different color for your BMP, you can 
change it in the Convert ICO>BMP Wizard. Click a color in the Images's palette, and you 
will see the change in the Image. (This Wizard page is not presented if your Icon does not 
have any Transparency)



Buttons
View All

Conversion Area:

Convert > ICO / BMP
Opens the appropriate Conversion Wizard (see BMP to ICO and ICO to BMP for more 
details).

Crop the BMP
This button appears only if the Loaded Bitmap measures between 32 x 32 and 72 x 72 
pixels, in which case the Crop form does not open automatically.    It is disabled after you 
have Edited a Bitmap.

Image Area:

Zoom
Shows a blowup of the Image.    It it is an Icon with Transparency, Clicking the Transp. 
button will show you which pixels are Transparent.

Edit
Opens the Touch Up Editor.        Same as Edit item in Image menu.
256- and 16 millions-color Images can only be Edited if your video mode is set to High or 
True Colors (the button is disabled if editing is not possible).

Save
Enabled only if the current image can be Saved; it opens the Save Wizard.

Images that may be Saved are
·    [Crop] from a BMP, as a new bitmap 
·    [Edited] Image, as a new Icon or Bitmap
·    Single Icon from a multi-Icon resource file, as a new Icon
·    Icons that are really Bitmaps, as a bitmap (.BMP extension)
·    If an Icon has 256 colors and measures 32x32 pixels, you can also Save it as a 16-color
Win 3.x icon, but only if your Video Mode is set to 256 colors (if there is only one Icon in the 
file, the button will be labeled Save 16c; if the Icon is part of a multi-icon resource file, you 
will be offered the choice in the Save Wizard. In both cases, the Wizard will show how the 
Icon will look with 16 colors only.

File Lists Area:

Refresh Lists
Refreshes both File Lists; useful if you have done some file managing outside of 
BMPTOICO.

View All
Opens the View module; enabled only if you have Selected the ICO/BMP File Lists.

Exit
Ends BMPTOICO.    If the current image can be Saved, you will be asked if you want to do it 



before. Cancelling the Save will also Cancel the Exit.



View All
When it opens...

When you Click on the View All button, or press Alt-V, you get another form which shows up
to twelve ICO images on the left. If there are no ICO files in the current directory, the form 
will show up to twelve BMP images.    The total number of ICO or BMP images in the 
directory is indicated in the form's title bar.    Each image has its file name, dimensions and 
color number under it. 

When you are working with the ICO/JPG option, you can only View All Icons.

Valid images:
Only Icons or Bitmaps that can be loaded into BMPTOICO can be Viewed (see valid formats
in BMP to ICO and    ICO to BMP). If an Image is larger than Icon size (32 x 32 pixels), it will 
be shown reduced to Icon size, but in its true proportions.    

BMPs that are too big (over 500 pixels in width or height) are indicated by a Big! icon; when 
you select it, the real BMP will show (Icon size); this is to avoid overloading systems with low
memory with too many big bitmaps, and to show the thumbnails much faster.

Non-valid images are identified by a big X image, and some pertinent information will 
replace the dimensions on the second line.

Select an image...
Click on it or on its name: it will be highlighted in blue.

Global functions:
· Display another group of twelve pictures:    Click on the << or >> button.

· Change the type of the pictures:    Click on the ICO or BMP Option at upper right; if there
are none of one type in the directory, or the File List is set to view JPGs/JPEs instead of 
BMPs, the corresponding Option will be disabled.

· Load the Selected Image into BMPTOICO's main form: Click on the Load button or 
press Alt-L; the button is disabled if the Selected image is not valid.

· Cancel:    Click on the Cancel button or press Alt-C or the <Esc> key.

File menu:
· Can also be Popped up by Right-Clicking on the Selected Image.

·        Zoom /    Full View:  its caption changes according to the actual size of the Selected
Image, and it is not visible if the Image is not valid.

·          Info, Delete, Rename: the last two items are disabled if the OPEN directory is on a 
Write-Protected floppy or on a CD-ROM



Image Menu
Except for Grab and Exit, all items in this menu are enabled only if an image is Loaded.    The 
whole menu is disabled when you are Changing the Directory.

Info
Dimensions, number of colors and icon images, format, etc., of the loaded image or of the 
file it was Extracted, Cropped from. Date, Size, etc. of the file.

Palette
Shows all the colors in the Palette (16- or 256-color images only); Click on a Color to get its 
RGB values.

Unload
Unloads the current image and resets the top portion in its starting state. If the current image
can be Saved, you will be asked if you want to do it before Unloading.

Edit    (Edit button)
Opens the Touch Up Editor.    256- and 16 millions-color Images can only be Edited if your 
video mode is set to High or True Colors (the menu item is disabled if editing is not 
possible). 

Save as...    (Save button)
This item is enabled only if the current image can be Saved; it opens the Save Wizard.    
See Buttons / Save for more details

Copy to ClipBoard
Sends the current image to the ClipBoard.

Grab from Screen
Opens the Screen Grabber with a snapshot bitmap of the current state of the screen 
(BMPTOICO will be automatically Minimized during the capture). 
 
When the Grabber is ready (wait for the beep), use the Mouse to select a rough area around
the image you wish to grab (the smallest size is 73 x 73 pixels),    then Click the OK button: 
your Selected Area is sent to BMPTOICO' s Crop form, where you can refine your Image.    
You can also Cancel the Grab by clicking the Cancel button.

If your Video Mode is 256 colors, be careful with palettes...

Exit    (Exit button)
Ends BMPTOICO.    If the current image can be Saved, you will be asked if you want to do it 
before. Cancelling the Save will also Cancel the Exit.



File Lists
PopUp Menu

There are two file lists in BMPTOICO; the left one shows all .ICO files in the current directory, 
the right one shows all .BMP files (or JPG/JPE files if that option is available to you: see BMP to 
ICO).    Both are always on screen so you can monitor your session at all times.

Use the Drive and Directory lists at left to change directories (if you cannot Save to the current 
directory, for ex. if it is on a CD-ROM, BMPTOICO will ask you to select another Save Directory 
when you first select the drive).

NOTE: The Win95 version of BMPTOICO uses the Long File Names. 

How to use the File Lists:
·      Click on a picture name to Highlight it (for the Right-Click PopUp menu),

·      Double-Click a file: it will Open the image into BMPTOICO. If the Image cannot be 
Loaded, the Icon will be a big X, and an explanation message will be displayed. 

Click the Refresh Lists button to Refresh the file lists (useful if you have done some file 
management outside of BMPTOICO).



PopUp Menu
When you Right-Click a File List while a FileName is highlighted, a PopUp menu appears: all 
its items apply only to the currently highlighted File.

Note: Delete, Rename and Copy are disabled if the current directory is on a Write-Protected 
floppy or on a CD-ROM.

Info
Get complete information about the file: Width, Height and number of Colors of graphic files; 
if it is a multi-format ICO file, get the total number of formats. You also get the size in bytes 
of the file, and the last date and time it was last saved; if the file is Read-Only, the message 
will say so.

Delete
Delete the highlighted file; you will be asked to confirm.

Rename
Rename the highlighted file.    You only need to enter the filename, the extension and path 
are automatically added by BMPtoICO (they remain the same).

Copy
Copy the highlighted file, with another name, to the Same directory.    Enter only the 
filename (see Rename above).

Change Ext. (BMP>ICO)
Windows 95 can use a BMP as an Icon if its extension is .ICO, and it will even try to set 
Transparency if the image is surrounded by a unique color.    Select this item to quickly 
transform your BMP into an ICO file (it will still be a bitmap, not a real Icon). It applies only to
the BMP list.

If you have registered BMPTOICO and have access to JPEG files, this menu item allows 
you to change the JPE extension (from Web files created on platforms other than Windows) 
to JPG so it can be loaded into programs like PaintShop Pro.

Move > Other Dir
Copy > Other Dir

Move or Copy the highlighted file to another Directory, with the same file name. Upon 
completion, you will be asked if you want to go to the other directory.



Touch Up Editor
See a Picture, Tools, Edit Menu, Other Menus

You can Edit both Icons and Bitmaps. You can edit 16-color images in any Video Mode, but 
Images with 256 or 16 millions colors can only be Edited if your Video Mode is set to High or 
True Colors.

What it does...
You can quickly Touch Up an opened Image with a few Tools: Move, Pick Color, Draw, Fill, 
Line and Rectangles; you can also Add Text to it.    If the Image in an Icon, you can create 
Transparent pixels (or change the existing ones).    If you prefer a full Icon Editor with all 
facilities, you are invited to try the full version, ICOEDIT, also from MyCat Software.

To Open it
Click the Edit button or press Alt-E , or select Edit in the Image Menu. The button and the 
menu item are disabled if the Image cannot be edited (see above).

When the Editor opens, the enlarged Icon is magnified in the Editing area at the left, and 
displayed in actual size at the top right (see a Picture).

Cursor Position:
You can always know where the cursor is and if a pixel is part of the Foreground or is 
Transparent (or Inverse Screen) as you move the mouse over the Editing Area. 

To Select a Tool:
The Tool palette consists of seven Tool buttons. Click on a button or select the item in the 
Tools menu.

To Select a Foreground Color:
Click on a color in the Color palette with the Left or the Right mouse button; you can thus 
use two colors at at time. 

Small Color Palette:
It contains only 16 colors, the Windows Standard ones  or    those 
that are closest to the Standard Palette in the Image's palette.

Full Palette: 
256- and 16 millions Color Images (you need High or True Colors to be able to edit them) 
also have access to a 256-color palette by Clicking the Full Palette button.

The Palette for 256-color Images is that of the Image, and might not contain the 16 Standard
Colors.    The Palette for 16-millions (24-bit) Images is a palette of 256 general colors (called 
"Rainbow" by MicroSoft). If you want a color that matches one already in your Image, use 
the Pick Color Tool.

Options:
· Foreground Colors:

Click a color in the Big Palette with the Left or Right mouse button
· 16-color Small Palette:

Click a color in the Big Palette, then use Drag and Drop to place it where you want in 
the small palette.



Click the OK button when done, or the Cancel button.

Transparent Color (Icons only):
Use this color if you want the screen behind the Icon to show through. The color is Pale 
Grey by default; but you can change it while editing the Transparency (click the Change TR 
Color button).    When editing 256- or 16 millions color Icons, you can select an RGB range 
to change many similar colors to Transparency at the same time (see Tools / Fill / 
QUICKTRAN Fill)

Screen Inverse:    Use this color (right button) if you want the screen colors behing the Icon 
to appear inversed. Honestly, I have never seen an Icon that use this property, but every 
Icon editor offers it...

To Select a Painting Option:
These options are disabled when you are using the Move or the Pick ColorTool.

·    Foreground: Select the Foregr. option, or Click one of the Foreground Colors; you can 
then use the Small Color Palette (or the Full one if your system is set to High or True 
Colors; see above). 

·    Transparency (Icons only): Select the Transp. option, or Click one of the Transparent 
colors; there is only one Color available for the Transparent Background (see above).

To Paint:
Painting is done in the Editing area at left; follow the simple instructions displayed at right.

To Check Transparency    (Icons only):
Click the Chk Transpar. button at any time to check which pixels will be Transparent in the 
Icon; Click the Icon button to return to editing.

To Add Text:
Click the Add Text menu. 

To Undo:
There are three levels (all in the Edit menu):
·    Undo / Redo Last:    reverses only the last operation; you can also Click the 

UNDO/REDO button.
·    Undo to Undo Image:  undoes to the "Undo to:" Image at upper right; you can also 

Double-Click the Image itself.
·    Reload Original Image: reloads the original Icon or Bitmap from BMPTOICO's main 

form.

When you are happy... or Not !
· Click the Load button to send the edited Image back to BMPTOICO's main form (to be 

Saved and/or Converted). To reflect the change, the Image Name will be preceded by 
"ED_".

· Or, Click the Cancel button to Cancel any editing and return to the original Image in 
BMPTOICO.



Editor: Picture



Editor: Tools
You can also Select each Tool with the Tools menu.

Except for Move and Pick Color (which works only with the Foreground option), all Painting 
Tools work with either the Foreground option (Color palettes available) or the Transparency 
one; the last operation is reversible indefinitely (until you perform another operation) by 
Selecting Undo Last / Redo Last in the    Edit menu, or pressing Ctrl+Z, or clicking the 
UNDO/REDO button.

 Move

Selects a rectangular region in the editing area, allowing you to Move it with its Transparent 
pixels (if any in the Selection) or Delete it.
Click in the editing area with a Mouse button to anchor one corner of the area you want to 
select, Drag the mouse until the flexible box that appears surrounds the area you want to 
select; Release the button.    If you make a mistake while selecting, click outside of the 
current selection and start over.
The area will remain selected after each move, ready to be moved again, until you Click 
outside it in the editing area or until you Click a button on the form: this will commit the 
Selection to the Icon.
 
To Delete the Selection:    Select Delete Selection in the Edit menu, or press the Del key.
To Move the Selection: Click inside its borders (where the Cursor changes to four white 

arrows), Drag the Selection where you want it, Release the button.
To Copy the Selection:    Hold down the CTRL key while you Click the Editing area to 

prepare for the Move. 

    Pick a Color
Use the Left or Right button to Pick a Foreground Color from the Editing Area; this button is 
disabled when you are editing the Transparency of an Icon.

    Draw
Paints individual pixels.
Click in the editing area, Release the button. To paint more than one pixel, Drag the mouse 
slowly before releasing the button. Undo    Last is updated each time you click the Editing 
area.

    Fill
Fills a closed area.
Click in the area to be Filled: all adjacent pixels which are the same color as the starting 
pixel will be colored automatically.

QUICKTRAN Fill:    if you are editing the Transparency of an    Icon with 256 or more 
Colors, you will see a scrollbar labeled RGB Tolerance.  Adjust it so that any pixel 
whose Red, Green and Blue values are within the Tolerance range (0-100, plus or 



minus) of the Red, Green and Blue values of the clicked pixel will also be changed to
the Fill Color.    This is useful to quickly create Transparency in Icons that don't have 
a uniform color as background.

    Line
Paints a one-pixel wide line.
Click in the Editing area to anchor one end of the line, Drag the mouse until it reaches the 
other end of the line you want to draw, Release the button.

    Rectangles
Paints a Hollow or Filled Rectangle.
Click in the Editing area to anchor one corner of the rectangle, Drag the mouse until it is the 
size and shape you want, Release the button.



Editor: Edit Menu
Undo Last / Redo Last     (Ctrl+Z, UNDO/REDO button)

Reverses the Last operation, from the time you Clicked the Editing area.    It is a toggle 
function, that works both ways until you perform another operation.    This item is disabled if 
no reversing can be done.    If you are using the Move Tool, only one Undo Last is permitted,
and no Redo Last.

Delete Selection     (Del)
Deletes the currently selected area.    Enabled only if you are using the Move Tool and have 
selected an area.

Undo to Undo To Image      (Double-Click the Undo To: Image)
Resets the Image to the state of the Undo Image at the upper right.    This item is disabled if 
the Edited Image is identical to the Undo one, or when you Add Text or Check an Icon's 
Transparency.

The Undo Image is updated each time you Change Tool or if you Change the Transparent 
Color; if you wish to update it while continuing to use a Tool, select another one, then 
reselect the one you need. 

Zoom on Undo To Image
To see a blowup of the Undo To: Image.

Reload Original Image
Reloads the original Image from BMPTOICO's main form.    You will be asked to Proceed or 
not.    When the Image is reloaded, the Editor will be reset to its opening state.



Editor: other Menus
Options

These toggle options are kept during the whole session in BMPTOICO, but are not saved for 
the next session.

Grid
Displays a grid over the Editing Area, or not (default is No Grid).

Transparency Dots
Shows little dots in the Transparent pixels in the Editing Area, or not (default is Dots); they 
don't show when you are Adding Text.

Add Text
Allows you to add one or more line of text,    in the Arial Font.    If you are editing an Icon, you
can Add Opaque or Transparent Text.

When you select this item, the Text function appears at the right. 

Enter Text in the white box, then play... Change the Size or Properties of the text font, Move 
it inside the Icon with the four Arrow buttons (or Arrow keys), Change its color by picking a 
color from the 16-color Palette (this palette is a copy of the one in the Editor; if your Image 
has 256 colors or more, you can Edit the palette before Adding Text (see Touch Up Editor / 
Full Palette)

· Add Line button:    Add another line; the previous line will be saved to the Image and 
cannot be erased anymore.

· Erase Li. button:    Starts a line over.
· OK button:    Returns to the Editor;    you will still be able to reverse the operation by 

Clicking the UNDO/REDO button or Selecting Undo Last / Redo Last in Edit menu.
· Cancel button:    Cancels the Text operation.
    



How to Register
           version 3.00 

    MyCat Software
 © 1995-1998, MyCat Software

BMPTOICO's Shareware version is not crippled in any way, except for the nagging screen upon 
opening and closing it, and the fact that you cannot Load JPEG files even if you have the 
VBJPEG.DLL file.    I prefer you to have the full package, and decide if you wish to register or 
not.    

BMPTOICO will stop running after the 30 days trial period is over, but will still show the nagging 
screen, so you can enter the registration number if you got one.

Registration price is only $20 US ($20 Cdn if you live in Canada and pay by cheque or money 
order).

Three Ways to Register:

· CompuServe: Go SWREG, select item #16971.

· REGNET:    RegNet can be reached on the World Wide Web at the following URL:        
http://www.swregnet.com

            or by calling 1 800 WWW2REG (1 800 999-2734) or (805) 288-1827.
RegNet    registration number:    #2096 
Cards accepted: 

· Snail-mail: Please make all cheques, money orders or bank drafts payable to Lucie Dorais, 
not to MyCat Software. You can use the ORDER.TXT file included in the zip.

Please send any correspondance to:
Lucie Dorais
603 - 222 Guigues
Ottawa, Ont.
K1N 5J2
Canada

Compuserve:  76440,623
E-mail:      76440.623@compuserve.com

ldorais@cyberus.ca
Web:            http://www.cyberus.ca/~ldorais/index.htm

Upon Registration:
You will receive a unique Registration number, which can be entered in the nagging screen 
(Click the Register NOW button), or at any time later by selecting Register in the Help 
menu.    You will also be told how to get Joe C. Oliphant's VBJPEG.DLL file needed to Load 
JPG/JPE files into BMPTOICO.

Special Thanks to...
· Michael Coker, who lives in a small village near Oxford, UK, and Joe Dacy, from Texas, for 



beta testing versions 2.0 and 3.0, and for making excellent suggestions.
· The picture used in the Shrink example was contributed by my sister Jacinthe; she is a 

kindergarten teacher.
· The 24-bit Loading Module is adapted from Joe C. Oliphant's "Graphic Viewer 2.0", a 

Visual Basic code example; this is where I got the VBJPEG.DLL file (freeware).
· The "Riven" picture used for the Desktop simulation (High or True Colors mode) is 

Copyrighted by CYAN(1997).
· Neko, the virtual cat, was created by Masayuki Koba and Dara T. Khani.






